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Vysázeno v LATEXu



Check.bin Editor Manual
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2.1 Typy bodů . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2 Typy propojenı́ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
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C.1 Chodci . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
C.2 Tramvaje a vlaky . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
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Úvod

Check.bin - je soubor, ve kterém je uložena navigačnı́ sı́t’ pro pohyb různých hernı́ch objektů. Sı́t’ je
tvořena body a jejich propojenı́m. Obsahuje navigaci pro:

• tramvaje, vlaky, letadla

• chodce

• AI ke zorientovánı́ se v prostoru (AI pro nepřátele a paniku)

Navigace jsou lineárně propojené body. Napřı́klad navigace pro chodce tvořı́ cestu, ovšem navi-
gace pro AI je jakási mřı́žka, která napomáhá při navigaci.

Check.bin obsahuje pouze navigaci! Chodci, tramvaje a jiné objekty jsou uloženy v souboru scene2.bin
(viz. přı́loha).

Tento dokument shrnuje pouze návod jak tvořit navigaci. Algoritmus, např. jak AI hledá nejkratšı́
cestu, už zavisı́ na samostudiu.

Reference:
http://cs.wikipedia.org/wiki/Dijkstr%C5%AFv_algoritmus
http://en.wikipedia.org/wiki/Dijkstra%27s_algorithmn
http://en.wikipedia.org/wiki/Shortest_path_problem
http://www.youtube.com/results?search_query=shortest+path

3

www.djbozkosz.wz.cz
http://cs.wikipedia.org/wiki/Dijkstr%C5%AFv_algoritmus
http://en.wikipedia.org/wiki/Dijkstra%27s_algorithmn
http://en.wikipedia.org/wiki/Shortest_path_problem
http://www.youtube.com/results?search_query=shortest+path


Check.bin Editor Manual
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Kapitola 1

Přı́prava pro použitı́ Check.bin Editoru

Pro správnou funkčnost je vhodné splnit všechny následujı́cı́ podmı́nky:

• Check.bin Editor (zkráceně CHE) - autor: zibob32.

• Hru Mafia ve verzi 1.0.

• V setupu Mafie Setup.exe je vhodné zakázat spuštěnı́ na celou obrazovku a zmenšit rozlišenı́,
než aktuálně použı́vané v operačnı́m systému.

• S pomocı́ MafiaDataXtractoru mı́t extrahovanou složku missions.

• Do složky Mafia\models je nutné zkopı́rovat všech 8 modelů bodů ze složky models u editoru
- pro vizualizaci bodů ve hře.

• Je vhodné mı́t misi bez sektorů. Sektory lze vymazat s pomocı́ nástroje Sector del (nutno
zálohovat původnı́ scene.4ds soubor mise). Viz. přı́loha.

• S pomocı́ (raději) BScriptView 4 - 6 (nabı́dka Insert→ Other) nebo DCED 2 ve scene2.bin v
dané misi mı́t vložen skript:

dim flt 1
// při stisknutı́ tlačı́tka úkolů (F1) zobrazı́ navigaci
label CHE
wait 1000
ctrl read 0, OBJECTIVES
if flt[0] = 1, -1, CHE
cleardifferences
loaddifferences ”CHED.chg”
goto CHE
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Kapitola 2

Body a propojenı́

2.1 Typy bodů

Obrázek 2.1: Mafia s vizualizovanými body navigace.
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Následujı́cı́ tabulka shrnuje nejdůležitějšı́ typy bodů:

Hexa typ - sizeof(unsigned short int); Popis

01 00
Chodci

02 00
AI (postavy, auta)

04 00
Tramvaje, vlaky, letadla

08 00
Mı́sto ke stánı́ pro tramvaje

10 00
Speciálnı́ mı́sto pro AI

Dalšı́ možnosti typů bodů mohou být nastaveny i v bitových přı́znacı́ch jednotlivých bodů.

2.2 Typy propojenı́
Propojené body majı́ mezi sebou standardně dvě vazby - každou jednı́m směrem. Tato tabulka obsa-
huje nejdůležitějšı́ propojenı́:

Hexa typ - sizeof(unsigned short int); Popis

01 00
Chodci

02 00
AI (postavy, auta)

04 00
Tramvaje, vlaky, letadla (směr dopředu)

84 00
Tramvaje, vlaky, letadla (směr zpět)

10 00
Jiné

Nenı́ explicitně řečeno, že body např. typu 01 00 musı́ mı́t stejný typ vazby (v tomto přı́padě 01
00). Ale napřı́klad tramvaje 04 00 majı́ vazby na okolnı́ dva body vždy 04 00 a 84 00, aby byl zaručen
směr, kterým tramvaj pojede.
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Kapitola 3

Prostředı́ editoru

Nı́že jsou obrázky z editoru doplněné o úplné překlady.

3.1 Hlavnı́ okno
Hlavnı́ okno obsahuje seznam všech bodů, které jsou uloženy v souboru. Pro vkládánı́ bodů nebývá
využı́váno. Přı́padně později pro dodatečnou úpravu bodů.

Obrázek 3.1: Mafii je vhodné spouštět v okně pro jednoduché přepı́nánı́ mezi okny.
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3.2 In-game tool
In-game tool je důležitý nástroj sloužicı́ pro zjišt’ovánı́ polohy hráče v reálném čase ve hře (pouze pro
verzi hry 1.0). Dále umožňuje na zjištěné souřadnice rovnou vkládat nové body, takže uživatel nenı́
zdržován laděnı́m pozic bodů. Body je také možné zobrazit přı́mo ve hře do okruhu asi padesáti metrů
od hráče.

Obrázek 3.2: Celkové rozhranı́ In-game tool.
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Tomáš Růžička www.djbozkosz.wz.cz
Copyright c© 2005 - 2012 Verze: 2012.08.28

3.3 La Tierra
La Tierra kreslı́ body a jejich propojenı́ do interaktivnı́ho náhledu a je primárně určen pro správu
vazeb bodů.

Obrázek 3.3: Dı́ky zobrazenı́ bodů v náhledu lze rychle vytvářet propojenı́.
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Tomáš Růžička www.djbozkosz.wz.cz
Copyright c© 2005 - 2012 Verze: 2012.08.28

Kapitola 4

Použitı́ editoru

4.1 Přı́prava
• Po načtenı́ požadované mise v Mafii je nutné přepnout se do operačnı́ho systému, spustit CHE

a otevřı́t (Soubor→ Otevřı́t) soubor check.bin ekvivalentnı́ mise.

• Po otevřenı́ mise v CHEdu je nutné otevřı́t okno In-game tool z nabı́dby Tools→ In-game mode.
In-game tool lze otevřı́t pouze v přı́padě již načtené ekvivalentnı́ mise.

• Po přepnutı́ do hry je možné vidět, jak se v In-game tool obnovujı́ souřadnice podle aktuálnı́
pozice hráče ve hře.

• Po kliknutı́ v In-game tool na tlačı́tko Generovat diference soubor, se vytvořı́ soubor diff\CHED.chg,
který obsahuje navigačnı́ body v blı́zkosti hráče. Tyto body lze načı́st ve hře stisknutı́m klávesy
F1 - úkoly.

4.2 Tvorba bodů
• Nejjednoduššı́ způsob spočı́vá v tom, že se hráč ve hře umı́stı́ na požadované mı́sto, kde je

potřeba vytvořit nový bod.

• V In-game tool musı́ být označena prvnı́ možnost - Editace bodů.

• V kolonce Typ bodu musı́ být vybrán požadovaný typ bodu (viz. tabulka výše), Rádius přechodu
bodu nastavit standardně na 50, Nezmáné bajty se vyplnı́ automaticky nulovýmı́ bajty a ID lze
nastavit také na nulu. Na toto ID se obvykle odkazuje přı́kaz skriptu: enemy move xx, kde xx je
právě ID daného bodu. Bod se vložı́ tlačı́tkem Přidat.

• Předchozı́ tři kroky je nutné opakovat pro vytvořenı́ požadovaného počtu bodů v dané oblasti
mise.

• Mezitı́m je vhodné kontrolovat umı́štěnı́ bodů ve hře s pomocı́ exportu do difference souboru a
obnovenı́m klávesou F1.
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4.3 Tvorba propojenı́
• Propojenı́ lze celkem pohodlně vytvořit s pomocı́ nástroje La Tierra. Okno se otevře přes

nabı́dku Tools→ La Tierra.

• V náhledu je možné se pohybovat bud’ rychleji pomocı́ miniatury vlevo nahoře okna nebo
drženı́m myši v náhledu za bı́lým ohraničenı́m. Vykreslenı́ bodů do výšky (Y souřadnice) lze
také omezit vpravo zadanou limitou.

• Pro vytvořenı́ vazeb je nutné mı́t označenou prvnı́ možnost Přidat vazbu, v kolonce Typ spojenı́
mı́t vyplněn daný typ (viz. tabulka výše) a mı́t zatrženou možnost Vytvořit propojenı́ v obou
směrech.

• Kliknutı́m na daný bod se vytvořı́ počátečnı́ vazba a kliknutı́m na dalšı́ bod se body propojı́.
Odpojenı́ myši se provede pravým tlačı́tkem myši.

4.4 Úprava a mazánı́ bodů a propojenı́
• Body a jejich propojenı́ lze upravovat a smazat přı́mo v hlavnı́m okně CHEdu. Kliknutı́m v

bloku bodů na Změnit - se upravená data se uložı́ nebo Odstranit - bod a jeho vazby se odstranı́.
Ovšem při odstraněnı́ bodů se u zbylých zainteresovaných bodů dané vazby změnı́ na neznámé.
Ty je také potřeba odstranit. Validnějšı́ způsob je nejprve odstranit vazby.

• Smazánı́ vazeb je možné provést v okně La Tierra, kde se označı́ druhá položka Odstranit vazbu
a kliknutı́m na body se prvnı́ vazba odstranı́. Poté je nutné ještě odstranit druhou vazbu a to se
provede kliknutı́m na ty samé body ovšem v obráceném pořadı́.

• Poté lze bezpečně smazat body v hlavnı́m okně.

4.5 Ukládánı́
• Soubor lze uložit kliknutı́m v menu hlavnı́ho okna na Soubor → Uložit. Editor automaticky

zálohuje předchozı́ check.bin soubor do složky BackUp v dané misi.
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Přı́loha A

Přı́klad navigace

Následujı́cı́ posloupnost obrázků zachycuje tvorbu bodů (typ 02 00) a jejich propojenı́ (typ 02 00) v
interiéru, kde plnı́ účel navigačnı́ sı́tě pro AI.

Mı́stnost bez navigace.
Bı́lá plocha znázorňuje oblast dostupnou pro postavy a šedá

plocha oblast nedostupnou - např.: pevné vybavenı́ interiéru, stoly,
skřı́ně, sloupy, atd.

Mı́stnost s body typu 02 00. Je dobré mı́t na paměti, že postavy,
pokud budou využı́vat navigaci, budou chodit pouze přes body a je-
jich propojenı́. Nemůže se stát (vyjma chodců), že by postavy šly
mimo toho propojenı́. Při tvorbě je vhodné body vkládat na vnějšı́
a vnitřnı́ rohy v mı́stnosti, kde postavy můžou manévrovat. Do roviny
je vhodné dávat body pouze v přı́padě, když jsou body přı́liš daleko
od sebe.

Červeně jsou vyznačeny body, které lze přı́padně také vložit,
protože sousednı́ body jsou přı́liš daleko od sebe.

Prvnı́ krok propojenı́ (typ 02 00) bodů (typ 02 00), tady nenı́ co
pokazit.
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Výsledné propojenı́. Při propojovánı́ je nutné dát pozor na vy-
tvořenı́ přı́liš velkých počtů vazeb - ty jsou zde červeně. Maximálnı́
počet vazeb z bodu by měl být ± 8.

Nakonec ukázka toho, jak by se navigačnı́ mapa změnila, pokud
by v mı́stnosti byly dveře.
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Tomáš Růžička www.djbozkosz.wz.cz
Copyright c© 2005 - 2012 Verze: 2012.08.28

Přı́loha B

Smazánı́ sektorů

Exportované body v CHG souboru jsou viditelné pouze v Primárnı́m sektoru. Problém nastává v
situaci, kdy je potřeba vizualizovat body v interiéru, jehož mı́stnosti jsou ve vlastnı́ch vizuálnı́ch
sektorech. Body totiž nejdou v těchto sektorech vidět.

Sektory a jiné nepodporované objekty Zmodeleru (glow objekty, atd) lze odstranit zkopı́rovanı́m
4ds souboru do stejné složky jako je program sector del.exe. V tomto přı́padě to bude soubor
scene.4ds z dané mise. Spuštěnı́m programu se soubor rovnou opravı́. Pro zobrazenı́ podrobnostı́
je možné program spustit přes terminál.

Je důrazně doporučeno zálohovat si původnı́ soubor, protože aplikace jej nevratně změnı́.
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Tomáš Růžička www.djbozkosz.wz.cz
Copyright c© 2005 - 2012 Verze: 2012.08.28

Přı́loha C

Definice a úprava objektů ve scene2.bin
souboru závislých na check.bin

C.1 Chodci
Aby navigačnı́ mapu využı́vali chodci, je nutné vložit do souboru scene2.bin objekt typu bod a definici
objektu, s ekvivalentnı́m názvem, typu Ped definition. To lze udělat např. s pomocı́ programu DCED 2
nebo DNC Extractor. Objekt typu bod je standardnı́ bod. Důležitá je hlavně definice chodců a vhodné
umı́stěnı́ bodu.

DCED 2 sice umožňuje vytvářet definice chodců, ale jak je dobře známo, poměrně často
poškozuje scene2.bin soubory, navı́c ani úprava chodců přes tento program nefunguje zcela korektně.
Proto je zde popsán bezpečnějšı́ způsob.

Při použitı́ DNC Extractoru je nutné nejprve načı́st misi obsahujı́cı́ definici chodců, Např. FREE-
RIDE. Následne je potřeba zatrhnout požadovanou položku v seznamu Objects, např. manhat-
tan people. A stejnou položku zatrhnout i v seznamu Objects definitions. Kliknutı́m na Extract se-
lected se ve stejné složce, jako je DNCextractor.exe, vytvořı́ složka DNCes a v nı́ požadované DNC
soubory. Po zavřenı́ a znovuotevřenı́ DNC Extractoru a načtenı́ požedované mise, je nynı́ možné
naimportovat DNC soubory s definicı́ chodců. To lze provést kliknutı́m na Import a vybránı́m DNC
souborů. Nakonec je potřeba vše uložit.

Pozor: pokud byla mise někdy v minulosti ukládána v Mafia World Editoru, tak je potřeba ji v
tomto editoru otevřı́t a vymazat (klávesa Del) bod s názvem Primary sector (ovšem pokud se v
misi nacházı́), který má totožný název s klasickým sektorem: Primary sector. Tento bod, od stejno-
jmenného sektoru v MWE lze rozpoznat tak, že při označenı́ sektoru Primary sector zčervená celá
mapa, ovšem při vybránı́ bodu se mapa nezměnı́.

Poté je nutné misi uložit. Pokud se v misi bod Primary sector nenácházı́, stačı́ pouze misi
přeuložit.

Problém je v tom, že při uloženı́ mise v MWE, editor totálně přeháže pořadı́ objektů v souboru,
včetně objektu sectoru s názvem Primary sector, který by měl být správně na úplném počátku sou-
boru. Při ukládánı́ v DNC Extractoru, editor na začátku souboru tento sektor nenalezne a proto jej
automatcky vložı́ bez ohledu na to, jestli se někde v souboru nacházı́. Toto je ilegálnı́ operace, protože
scene2.bin nesmı́ obsahovat dva objekty stejných názvů, resp. definice objektů stejných názvů (ne-
platı́ pro dvojci objektu a definici objektu stejných názvů). A o to vı́c je riziko závažnějšı́, když se
jedná o primárnı́ sektor, na který se implicitně lepı́ všechny ostatnı́ objekty.
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Tomáš Růžička www.djbozkosz.wz.cz
Copyright c© 2005 - 2012 Verze: 2012.08.28

Stále je to ovšem lepšı́ způsob, než exportovat resp. importovat data přes DCED 2, u kterého se
vyskytujı́ problémy i při těchto operacı́ch. Navı́c DNC Extractor umožňuje export resp. import vı́ce
objektů najednou, např. i celé mapy.

Vložený objekt bodu obsahuje souřadnice, které jsou důležité pro určenı́ mı́sta, kde se budou
chodci generovat. Bod lze umı́stit na požadované mı́sto s pomocı́ BScriptView nebo Mafia World
Editoru.

Rozšı́řené vlastnosti jsou uloženy v definici objektu, kterou lze bezpečně upravit s pomocı́ libo-
volého hexa editoru. Následujı́cı́ obrázek shrnuje důležitá nastavenı́ chodců v definici:

Obrázek C.1: Analýza definice objektu chodců ze souboru scene2.bin.

Chodci se generujı́ v mı́stě mapy určené polohou bodu do vzdálenosti od bodu: modrá - float.
Dále je generovánı́ podmı́něno polohou hráče, přičemž chodci se vytvářı́ v kruhové oblasti určené

vnějšı́m a vnitřnı́m rádiusem: fialová, červená, oranžová, žlutá - vše float.
Na navigačnı́ mapě lze generovat chodce s maximálnı́m počtem: zelená - unsigned int.
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Dále je definován počet chodců v databázi: tyrkysová - unsigned int a samotné názvy chodců.
Řetězec s názvem modelu chodce je ukončen nulovým bajtem a zbytek je vyplněn bajty 0xCD do
celkového počtu sedmnácti bajtů každé položky. Položek je tolik, kolik se určeno hodnotou před
databázı́.

Nakonec je pro každou položku definována poměrová hustota: tyrkysová - unsigned int.

Přes hexa editor se nesmı́ měnit délka souboru, protože by neseděla struktura souboru - na začátku
každé položky v souboru je uložena délka dané položky.

Ovšem je možné měnit délku definice objektu v DNC souboru. Poté je nutné přepočı́tat délku
položky na začátku souboru.

C.2 Tramvaje a vlaky
Objekt modelu vagónu tramvaje a definici lze zı́skat s pomocı́ DNC Extractoru způsobem popsaným
v minulé kapitole.

Vagón je nutné umı́stit přı́mo na trasu navigace tramvaje. Rozšı́řené vlastnosti jsou uloženy v
definici objektu, kterou lze upravit opět s pomocı́ hexa editoru. Následujı́cı́ obrázek shrnuje důležitá
nastavenı́ tramvaje v definici:

Obrázek C.2: Analýza definice objektu tramvaje ze souboru scene2.bin.

Nejdůležitějšı́ jsou vlastnosti: počet napojených vagonů, vzdálenost mezi vagóny a maximálnı́
rychlost. Tu vlak dosáhne pouze tehdy, když jsou mezi navigačnı́mi body velké vzdálenosti.

Přes hexa editor se nesmı́ měnit délka souboru, protože by neseděla struktura souboru - na začátku
každé položky v souboru je uložena délka dané položky.

Ovšem je možné měnit délku definice objektu v DNC souboru. Poté je nutné přepočı́tat délku
položky na začátku souboru.
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Přı́loha D

Převod čı́sel

Unsigned int je neznaménkové celé čı́slo uložené v hexa tvaru. Float je reálné čı́slo uložené dle normy
IEEE 754 ve tvaru: znaménko * 2 na exponent * mantisa.

Důležitou poznámkou je, že se čı́sla standardně ukládajı́ od nejméně významného bajtu po nejvı́ce
významný bajt. To znamená, že při převáděnı́ je nutné obrátit pořadı́ bajtů.

Přı́klad pro celé čı́slo: decimálnı́ tvar: 22 384 hexa tvar: 00 00 56 12 uložený tvar: 12 56 00 00.
Přı́klad pro reálné čı́slo: decimálnı́ tvar: 15.256 hexa tvar: 41 74 18 93 uložený tvar: 93 18 74 41.
Celá čı́sla lze převádět klasicky v kalkulačce.
Reálná čı́sla je možné převádět s pomocı́ online konvertoru: http://www.h-schmidt.net/

FloatConverter/IEEE754.html nebo s pomocı́ programu Base Converter a nebo přı́mo v
hexa editoru Hex Workshop.

Při použitı́ Base Converteru je nutné nastavit pořadı́ bajtů na Intel a datový typ na float (32). Poté
lze přı́mo kopı́rovat čtveřičky bajtů (bez prohozenı́ pořadı́) z hexa editoru do konvertoru.
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